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1200 V SOI gate driver 2ED1324S12P evaluation board

About this document

Scope and purpose

This user guide provides an overview of the evaluation board EVAL-2ED1324S12PM1 including its main features,
key components, pin assignments, and mechanical dimensions. This guide also describes how to run a brushless
direct current (BLDC) motor.

EVAL-2ED1324S12PM1 is a power evaluation board that includes an M1 connector, one EasyPIM™ 1B 1200V, 25 A
three-phase input rectifier power integrated module (PIM) with TRENCHSTOP™ IGBT7, and three half-bridge
silicon-on-insulator (SOI) gate drivers for motor drive applications. In combination with either EVAL-M1-101T or
other control board with compatible M1 connectors, the EVAL-2ED1324S12PM1 features and demonstrates
Infineon’s IGBT module and SOI gate driver technology for motor drives.

EVAL-2ED1324S12PM1 was developed to support users during their first steps in designing applications with
Infineon’s EasyPIM™ 1B IGBT 7 power integrated module and the half-bridge gate driver.

Intended audience

This document is intended for all technical specialists who have a knowledge of motor control and electronic
converters capable of handling several kilowatts of power. The board must be used only under laboratory
conditions.

Evaluation board

EVAL-2ED1324S12PM1 is designed to evaluate the 1200 V SOI half-bridge gate driver 2ED1324S12P along with the
EasyPIM™ 1B IGBT 7 power integrated module FP25R12W1T7_B11.

This board will be used during design-in process for evaluation and measurement of characteristics, and proof
of data sheet specifications.

Note: PCB and auxiliary circuits are NOT optimized for final customer design.

Ordering information

Base part number Package Standard pack Orderable part number
Form Quantity

EVAL-2ED1324S12PM1 MADK EVAL Boxed 1 EVAL2ED1324S12PM1TOBO1
2ED1324S12P PG-DS0O-24 Tape and Reel 1000 2ED1324S12PXUMA1L
EVAL-M1-101T MADK EVAL Container 1 EVALM1101TTOBO2
FP25R12W1T7_B11 AG-EASY1B Tray 24 FP25R12W1T7B11BPSA1
ICE5QSAG PG-DSO-8 Tape and Reel 2500 ICESQSAGXUMA1L
IMBF170R1KOM1 PG-T0O263-7 Tape and Reel 1000 IMBF170R1KOM1XTMA1
IFX25001TF V33 PG-TO252-3 Tape and Reel 2500 IFX25001TFV33ATMA2
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Important notice

Important notice

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board
(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration,
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).

Environmental conditions have been considered in the design of the Evaluation Boards and Reference
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards
has been tested by Infineon Technologies only as described in this document. The design is not qualified
in terms of safety requirements, manufacturing and operation over the entire operating temperature
range or lifetime.

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the
same procedures as regular products regarding returned material analysis (RMA), process change
notification (PCN) and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for
evaluation and testing purposes. In particular, they shall not be used for reliability testing or production.
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other
requirements of the country in which they are operated by the customer. The customer shall ensure that
all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant
requirements and standards of the country in which they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and
managed according to the terms and conditions set forth in this document and in other related
documentation supplied with the respective Evaluation Board or Reference Board.

It is the responsibility of the customer’s technical departments to evaluate the suitability of the
Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness
and correctness of the information provided in this document with respect to such application.

The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not
cause any harm to persons or third-party property.

The Evaluation Boards and Reference Boards and any information in this document is provided "as is"
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to
warranties of non-infringement of third-party rights and implied warranties of fitness for any purpose, or
for merchantability.

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation
Boards and Reference Boards and/or from any information provided in this document. The customer is
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or
damages arising out of or resulting from any use thereof.

Infineon Technologies reserves the right to modify this document and/or any information provided
herein at any time without further notice.
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Safety precautions
Note: Please note the following warnings regarding the hazards associated with development systems.

Table1l Safety precautions

Warning: The DC link potential of this board is up to 800 VDC. When measuring voltage
waveforms by oscilloscope, high voltage differential probes must be used. Failure to do
so may result in personal injury or death.

Warning: The evaluation or reference board contains DC bus capacitors which take
time to discharge after removal of the main supply. Before working on the drive
system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to
do so may result in personal injury or death. Darkened display LEDs are not an
indication that capacitors have discharged to safe voltage levels.

Warning: The evaluation or reference board is connected to the grid input during
testing. Hence, high-voltage differential probes must be used when measuring voltage
waveforms by oscilloscope. Failure to do so may result in personal injury or death.
Darkened display LEDs are not an indication that capacitors have discharged to safe
voltage levels.

Warning: Remove or disconnect power from the drive before you disconnect or
reconnect wires, or perform maintenance work. Wait five minutes after removing
power to discharge the bus capacitors. Do not attempt to service the drive until the bus
capacitors have discharged to zero. Failure to do so may result in personal injury or
death.

Caution: The heat sink and device surfaces of the evaluation or reference board may
become hot during testing. Hence, necessary precautions are required while handling
the board. Failure to comply may cause injury.

Caution: Only personnel familiar with the drive, power electronics and associated
machinery should plan, install, commission and subsequently service the system.
Failure to comply may result in personal injury and/or equipment damage.

Caution: The evaluation or reference board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when
installing, testing, servicing or repairing the assembly. Component damage may result
if ESD control procedures are not followed. If you are not familiar with electrostatic
control procedures, refer to the applicable ESD protection handbooks and guidelines.

Caution: A drive that is incorrectly applied or installed can lead to component damage
or reduction in product lifetime. Wiring or application errors such as undersizing the
motor, supplying an incorrect or inadequate AC supply, or excessive ambient
temperatures may result in system malfunction.

Caution: The evaluation or reference board is shipped with packing materials that
need to be removed prior to installation. Failure to remove all packing materials that
are unnecessary for system installation may result in overheating or abnormal
operating conditions.

>R B B BB
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1 The board at a glance

The evaluation board EVAL-2ED1324S12PM1 provides an AC (or DC) input and a three-phase output for power
motors. It contains the gate driver IC 2ED1324S12P, the EasyPIM™ 1B IGBT 7 power integrated module
FP25R12W1T7_B11, a heat sink, a relay and a power resistor for inrush current limiter, bus capacitors, a single
shunt for current sensing, a voltage divider for DC-link voltage measurement, and other peripheral circuits.

1.1 Scope of delivery

The EVAL-2ED1324S12PM1 evaluation board is delivered along with a daughter board (EVAL-2ED1324S12PM1D)
for the gate drivers, and an iMOTION™ 2.0 M1 interface connector.

The package also contains a quasi-resonant, pulse-width modulation (PWM) controller; a CoolSiC™ MOSFET-
based auxiliary power supply to provide 15V and 3.3 V; inrush current limiter; a single shunt for current sensing
and overcurrent protection; and a voltage divider for DC-link voltage measurement. The board can be operated
directly with the required three-phase AC input or DC power supply without any additional components.

1.2 Block diagram

Figure 1 shows a typical application diagram of EVAL-2ED1324S12PM1 for driving a BLDC motor. The system
adopts a single-shunt configuration, which is prevalent for current BLDC motor drive applications.

Inrush cunrent

. limiter -

e AA AA AA

M1 Interface

M1 Interface

iMotion Control Board

Note: AC input or DC input (select one)
Figure 1 Typical application block diagram of EVAL-2ED1324S12PM1

The functional blocks of EVAL-2ED1324S12PM1 are presented in Figure 2 and Figure 3.
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DCinput
ACinput

U/V/W phase-out
Daughter board
Gate driver ICs
iMOTION™ 2.0 M1
interface
Auxiliary power supply
Bus electrolytic
capacitors

9. Inrush protection
10. Mother board
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Figure 2 Functional blocks of EVAL-2ED1324S12PM1 (top view)

1. EasyPIM™ 1B module
FP25R12W1T7_B11
2. Single shunt (3 parallel)
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Figure3  Functional blocks of EVAL-2ED1324S12PM1 (bottom view)
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1.3 Main features

The main features of EVAL-2ED1324S12PM1 include:
e Nominal AC input voltage of 380V

e Inrush current limiter

e Design for maximum 3 kW motor power output

e Single shunt for current sensing

e Sensing of DC-link voltage

e Internal negative temperature coefficient (NTC) thermistor for over-temperature protection

e +15Vand +3.3Vauxiliary power supplies on the board
e M1l interface compatible with the iMOTION™ control board

1.4 Board parameters and technical data

The key specifications of EVAL-2ED1324S12PM1 are listed in Table 2.

Table 2 Specifications of EVAL-2ED1324S12PM1

(infineon

. Value Unit
Parameter Symbol | Conditions
Min. ‘ Nom. ’ Max.
Input
Input voltage Vin AC voltage 120 | 380 | 500 |V
Input current Iin Input current - - 58 |A
Output
Output current lout RMS phase-out current - - 6.7 |A
utput power Por | log forcedancootmg | T | |3 |k
Overcurrent protection loce Peak phase-out current - - 249 |A
Thermal protection
NTC over-temperature ] o ) 1.09 | 2.75 - Vv
threshold VTH Configuration in MCEWizard 100 o - o
Switching frequency
requency Fo ol L I
Auxiliary power supply
Gate driver power supply Vee - 15 - v
Controller power supply - 33 - v
System environment
Ambient temperature ‘ With adequate cooling method - 25 ‘ - °C
PCB characteristics
L Length - 130 - mm
Dimensions Width - 120 - mm
H Height - 111 - mm
User guide 7of36 V1.0
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. Value Unit
Parameter Symbol | Conditions .
Min. ‘ Nom. ‘ Max.
Input
Layer - 2 -
PCB thickness - 1.6 - mm
Copper thickness - 2 - oz.
Weight Weight of the entire PCB assembly - 1060 | - g
Material FR-4, RoHS-compliant
User guide 80f36 V1.0
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2 System and functional description

2.1 Getting started with EVAL-2ED1324S12PM1

To run the motor system, a combination of the IMOTION™ power board EVAL-2ED1324S12PM1 and a matching
iMOTION™ control board (e.g. EVAL-M1-101T) are required. This chapter explains how to set up the system and
get started with the iIMOTION™ development platform.

The power board EVAL-2ED1324S12PM1 can run a BLDC motor by connecting to the iMOTION™2.0 control board
EVAL-M1-101T through an M1 interface. The system connection is shown in Figure 4, and the test results are listed
in Section 4.1.

U/V/W phase-out AC Input

1]

e 'reye

X10. X1 x12 x13 X14 X15.
G N o) Tal 8 Rla ¢
EVAL'M l-lOlT e - T 5 ey
d=HR1S. R2% =R4, RO =RI1 RIGE =R18
o] c17, D2w__we, D4w__°

U2 u3
4 W DC input
‘ ‘\

>y BN A R A At :.)

5 ¢90,@

0% =Rt & @ 5 K - 6,@6
Bebicis ¢ Y an (infineon
5 =
2 0 2 2 0606 5\:ADL:2ED|3268(:|2PMID

(Infineon

EVAL-2ED1324S12PM1
V1.0.

Figure 4 The system connection for running a BLDC motor

2.1.1 The iMOTION™ control board

You can order the Infineon control board EVAL-M1-101T from https://www.infineon.com/cms/en/product/
evaluation-boards/eval-m1-101t and download the latest IMC101T-T038 MCE software package from
www.infineon.com/imotion-software.

After obtaining EVAL-M1-101T and the latest software, connect your PC to the control board via a USB cable to
program and tune it.

User guide 90f36 V1.0
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1. Connect EVAL-M1-101T’s M1 20-pin interface connector J2 to the daughter board X22.

2. In the MCEWizard, enter the system and operating parameters of the target motor and the hardware
parameters of the evaluation board. This data is used for calculating the digital parameter set of the
controller, representing the complete motor drive system.

3. Go to the Verify & Save page and click Calculate Parameters. Then, save the drive parameter set into your
project directory by clicking Export to MCEDesigner file (.txt) (see Figure 6). This saved drive system
parameter file will be used later by the MCEDesigner. Refer to Section 2.1.4 or the MCEWizard user guide for
more information.

Connect motor phase outputs (X9 on the mother board) to the motor.
Connect AC input to the power input connector (X8 on the mother board), then power on the system.
Start the MCEDesigner tool.

Click File > Open to open the MCEDesigner default configuration file (.irc) for the IMC101T-T038 controller
(IMC101T_Vxxx.irc). The IMC101T_Vxxx.irc file is included in the IMC101T-T038 MCE software package.

8. The MCEDesigner should automatically connect to the EVAL-M1-101T control board using the default COM
port (indicated by a green circle next to the “COMx Up” status in the bottom frame of the MCEDesigner GUI).
If the connection cannot be established, change the COM port as follows:

a) Open the System Page window.
b) Click Preferences > Connection > Connect using.
c) Choose one of the other available COM ports from the drop-down list.
Program the system parameters into the internal SRAM of the iIMOTION™ IC using the following steps:
a. Click Tools > Programmer and select Program Parameters.
b. Browse and select the System Drive Parameters file created in step 3. See Section 2.1.4 for more
information.
10. Start the motor by clicking the green traffic light button in the control bar. To stop the motor, click the red
traffic light button in the control bar.

No ok

©

2.1.2 iMOTION™ development tools and software

The EVAL-2ED1324S12PM1 evaluation board can run a BLDC motor when connected to an external control board
EVAL-M1-101T. Users must configure the IMOTION™ development tool and software according to the system and
BLDC motor parameters.

The MCEDesigner and MCEWizard are based on MCEDesigner v2.3.1 and MCEWizard v2.3.1, and can be
downloaded together with supported files from http://www.infineon.com/imotion-software.

2.1.3 MCEWizard setup overview

Use the MCEWizard to configure the parameters for the evaluation board or motor. Figure 5 shows the Welcome
page of the MCEWizard. Here, users can select the control board or power board from a drop-down list. Infineon
releases new control and power boards regularly. Therefore, it is possible that some of the latest power boards
have not been pre-configured in the MCEWizard tool and cannot be selected from the drop-down menu. In that
case, users can select another power board (as similar as possible) and follow the setup steps in the MCEWizard
by entering parameters specific to the power board chosen. Please refer to the application note of the
corresponding power board for additional information.

After selecting the modular application design kit (MADK) control board and the power board, click Next in the
right-hand bottom corner of the Welcome page to start the MCEWizard system setup process.

User guide 10 of 36 V1.0
2023-05-08


http://www.infineon.com/imotion-software

EVAL-2ED1324S12PM1 User Guide
1200 V SOl gate driver 2ED1324S12P evaluation board

System and functional description

infineon

File JumptoPage Help

Welcome Page

Using System Configuration File:
EVAL-M1-101T-05-65D.mc2

This motor control system is an
evaluation kit for complete inverter-
controlled motor drive applications
based on EVAL-M1-101T iMOTION
MADK controler board (based on
IMC101T-T038 iMOTION controller)
and EVAL-M1-05-65D MADK inverter
board (based on IRSM505-065DA2
CIPOS Micro IPM).

Following two options are available.

If no hardware change is done on this
board and there is no plan to change
default control settings:

Select > Default Hardware and Control
Settings.

Open System Configuration File

Q MCEWizard 2.3.0.1 - C:/Users/wchu1/WDC/IPC/ISD/IPM/imotion/iMotion 2/SiC board/Golden age motor.mc2 =

iMOTION™ 2.0 System Configuration Wizard

Infineon
-

Get MADK Hardware Info Get iMOTION™ Info

Save System Configuration File

Previous

Next

Figure5 Welcome page of the MCEWizard

The iIMOTION™ system enables users to easily test different combinations of control and power boards with their
motors. Users should be familiar with system-level parameters related to the motor used. There are a limited
number of parameters specific to the control board or power board hardware. Table 3 lists the hardware
parameters specific to the EVAL-2ED1324S12PM1 power board for MCEWizard setup. Similar tables are available
for each control board in its application note. A combination of data in this table and the corresponding table of
the control board provides sufficient information to set up the motor drive system quickly.

Table3 MCEWizard setup overview table

Parameter Value

Control board selecting EVAL-M1-101T for example
Motor 1 shunt configuration Single shunt

Controller supply voltage +3.3V

Max DC bus voltage 780V

DC bus sensing high resistor 4000 kQ

DC bus sensing low resistor 13kQ

NTC temperature shutdown value

Refer to the control board’s application note [6]

Gate sense low-side devices

Highis true

Gate sense high-side devices

High is true

Motor 1 current input scaling

control board’s application note [6]

Calculated in the corresponding section of the

After all the MCEWizard questions are answered, the Verify & Save page opens (see Figure 6.)
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(infineon

n MCEWizard 2.3.0.1 - C\O1-Workspace\02-2ED1324 + IGETY module - Jinsheng Eva\03-Firmware\Firmware debugiHig... - x
File JumptoPage Help
|‘|.'erify & Save Page - |
Verify Parameters
|Calculate Parameters| |Displa'y Parameters Rﬂsults| |E)qmrl to MCEDesigner File (.b:t)|

Double-Click an item to JUMP to its associated question

Figure6  Verify & Save page of the MCEWizard

Click Calculate Parameters and then Export to MCEDesigner File (.txt) to save the parameter file. This file will

be used by the MCEDesigner in the next steps.
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2.1.4 MCEDesigner setup overview

The MCEDesigner is a user interface to access or debug the control board. Open the MCEDesigner and then open
the IMC101T_xx.irc file. The main display page for EVAL-M1-101T opens, as shown in Figure 7.

E Systern - EVAL-2ED1324512PM1_HighPower.irc - MCEDesigner Ver 2. 3. 0. 1 - Infineon Technologies — O x

File View Preferences Tools Window Help
5 88 ®
¥ | System - EVAL-2ED1324512PM1_HighPower.irc =
W C\O1-Workspace\0 ~
= Monitor Definiti
#— B FluxrAngle &
# @ MotorSpeed
w— B lu & Iv_Fast
#— B Ju & v_Slow
o B u & Flx_M
B Flx_Q & Flx _t
#— B u & MotorS
o @ lu & Trg v
< >

aj
X3

] —

[
[l

B CAD1-Workspace\0 A~
=—{& User Applicatior

=M Start Motor
=8 Stop Motor
# M Drive Status
M Emergency £
=8 Configure M
B Reference Sg

+— B Clear Faults
# @ VYF Diagnost
# B Read DC Vol

o B Criernnt L

< >

For Help, press F1 IMC101T COMS Down |[Trig Idle | ® Motor1 Ini * Systemn Inactive

Figure7  MCEDesigner’s main display for EVAL-M1-101T

After the drive system parameter file has been programmed into the IMC101 controller, and the motor drive
system powered, the MCEDesigner can be used to start/stop the motor, display motor current traces, change the
motor speed, modify drive parameters, and perform many other functions. Please refer to the MCEDesigner
documentation [8] for more details.

2.2 Description of functional blocks

The motor inverter in EVAL-2ED1324S12PM1 hardware design is implemented by three 1200 V SOI half-bridge
gate drivers 2ED1324S12P and one EasyPIM™ 1B 1200 V, 25 A three-phase input rectifier power- integrated
module (PIM) with TRENCHSTOP™ IGBT7 FP25R12W1T7_B11. The auxiliary power supply is based on the quasi-
resonant controller ICE5QSAG and CoolSiC™ MOSFET IMBF170R1KOM1.
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2.2.1 Overview of 2ED1324S12P

Figure 8 shows the functional block diagram of 2ED1324S12P. For more information such as static and dynamic
electrical characteristics of the gate driver, please refer to the datasheet of 2ED1324S12P.

VB
S
o Input VSS/COM Latch
AN g > ner I N : HO
Deadtime & Shifter UV Detect
Shoot-Through —
Inout Prevention R
np
LIN o—e—{ [T >—{ Noise VS
filter
g HC
z~
VSS 'j .
L L 1
petect vee
ITRIP of ITRIP etec
Noise
filter % I:
VSS/COM .
% Level I Delay Driver LO
Shifter \/‘/
) COM
\(
RFE *4|:>— fter
% LC
+
A— —

—

T

Figure 8 Functional block diagram of 2ED1324S12P

The main features of 2ED1324S12P include:

e Unique Infineon thin-film silicon-on-insulator (SOI) technology
- Floating channel designed for bootstrap operation
e Maximum bootstrap voltage (VB node) of + 1225V
e Operating voltages (VS node) up to + 1200 V
e Negative VS transient voltage immunity of 100 V
- With repetitive 700 ns pulses
e 2.3A/2.3Apeakoutputsource/sink current capability
e Integrated ultra-fast overcurrent protection (OCP)
- +5% high accuracy reference threshold
- Lessthan 1 us overcurrent sense to output shutdown
e Integrated active Miller clamp (AMC) with 2 A sink current capability
e Integrated short-circuit clamp (SCC) function
e Integrated ultra-fast, low-resistance bootstrap diode
e Integrated dead-time and shoot-through prevention logic
e Enable, fault, and programmable fault clear input
e Logicoperational up to-8VonVS pin
e Independent per channel undervoltage lockout (UVLO)
e 25VVCC supply voltage (maximum)
e Separate logic (VSS) and output ground (COM)
e Greater than 5 mm clearance / creepage
e 2 kVHBM ESD capability
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Table 4 Absolute maximum ratings of 2ED1324S12P

Symbol Definition Min. Max. Units
Ve High-side floating well supply voltage "°t! -0.5 1225
Vs High-side floating well supply return voltage o** Vg - 25 Vg +25
High-side floating supply voltage (Vg vs. Vs)
Ves . -1 25
(internally clamped)
Vuome | Floating gate drive output voltage -0.5 Vs+ 0.5
Low-side supply voltage (Vcc vs. Vss) (internally
Veeeno -1 25
clamped) v
Low-side supply voltage (Vcc vs. Vcou) (internally
Vee -1 25
clamped)
Vione | Low-side output voltage -0.5 Vect 5
Vin Logic input voltage (HIN, LIN, RFE, ITRIP) Vss-5 Vec+0.5
VLCLAMP Pin LC Voltage -0.5 Vcc +0.5
VHCLAMP Pin HC voltage Vs -0.5 VB +0.5
Maximum short-circuit clamping time
t — 10 S
o (IcLamp/our=500mA) H
dVs/dt | Allowable Vs offset supply transient relative to COM — 50 V/ns
Po Package power dissipation @ T, <+25°C "°*¢? — 1.5 W
Rthia | Thermal resistance, junction to ambient **** — 81
Characterization parameter, junction to package °C/W
LPJ""F’ tOp Note 3 5
T, Junction temperature -40 150
Ts Storage temperature -55 150 °C
T, Lead temperature (soldering, 10 seconds) — 300

Note 1: There is an additional power dissipation in the internal bootstrap diode between pins VCC and VB for activated bootstrap diode in
case VCC > VB.

Note 2: Consistent power dissipation of all outputs. All parameters inside operating range
Note 3: Obtained in a simulation on a JEDEC-standard and Ta =50 °C, PD= 1W, PCB: JEDEC 2s2p (JESD 51-5)
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2.2.2 Overview of FP25R12W1T7_B11

The FP25R12W1T7_B11 is an EasyPIM™ 1B 1200 V,25 A three-phase input rectifier PIM (power integrated-
module) IGBT module with TRENCHSTOP™ IGBT7, emitter-controlled 7 diode, NTC and PressFIT contact
technology.

Figure 9 shows the circuit diagram of FP25R12W1T7_B11. For more information about the module, please refer
to the datasheet of FP25R12W1T7_B11.

P P1
& O o}
T1
t
| To—e
L 20 $
L 30
12
N
Figure9 Circuit diagram

The main features of FP25R12W1T7_B11 include:

e Electrical features
- VCES =1200V
- lcnom=25A/Icru=50A
- TRENCHSTOP™IGBT7
- Overload operation up to 175°C
- Low VCEsat
e Mechanical features
- High power density
- PressFIT contact technology
- 2.5kVAC 1 mininsulation
- Al,Os substrate with low thermal resistance
- Compact design
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2.2.3 Overview of ICE5QSAG

The quasi-resonant fly-back PWM controller, which is the fifth and latest generation, offers high performance and
a comprehensive protection package to increase system robustness.

Figure 10 shows the functional block diagram of ICE5QSAG. For more information regarding the PWM controller,
please refer to the datasheet of ICE5QSAG.
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Figure 10 Circuit diagram

The main features of ICESQSAG include:

e Novel quasi-resonant operation and proprietary implementation for low EMI

e Enhanced active burst mode with selectable entry and exit standby power

e Active burst mode to reach the lowest standby power

e Faststartup thanks to through cascade configuration

o Digital frequency reduction for better overall system efficiency

e Robust line protection with input overvoltage protection and brownout protection
e Comprehensive protection

e Lead-free plating, halogen-free mold compound, RoHS compliant
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2.2.4 Overview of IMBF170R1KOM1

IMBF170R1KOM1 isa CoolSiC™ 1700V, 1000 mQ SiC MOSFET in a TO-263-7 high-creepage package; optimized for
fly-back topologies. It can be used in auxiliary power supplies connected to DC-link voltages from 600 V up to
1000 V in numerous power applications. For more information regarding the power device, please refer to the
datasheet of IMBF170R1KOM1.

The main features of IMBF170R1KOM1 include:

e Use of silicon carbide as revolutionary semiconductor material

e Optimized for fly-back topologies

e 12V/0V gate-source voltage compatible with most fly-back controllers
e Very low switching losses

e Benchmark gate threshold voltage, Vesin = 4.5V

e Fully controllable dV/dt for EMI optimization
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3 System design

This chapter covers the hardware design of EVAL-2ED1324S12PM1 in detail. Users can modify the circuit or re-
select the component values based on actual applications in the field.

3.1.1 DC-link voltage measurement and inrush current limiter

Bus capacitors should be large enough to stabilize the bus voltage. The resistors R1 and R3 are used to balance
the voltage on the electrolytic capacitors in series, and the inrush current limiter (K1, R7) as shown in Figure 11.

Note: The resistor R11 is soldered on the mother board of EVAL-2ED1324S12PM1. Therefore, the 13.3 kQ pull-down
resistor located on the EVAL-M1-101T control board must be removed.

vee K1
T L 2 [ 1
2R ITI
4 ) 3 SGND_+15V
T9GV1L14-12
X7 R7 DC+
N 2 _POW_IN — o
L 1 —_
> 100R Hl
1 _lftcl
. 470uF
Power input DRZ
|l 1MEG
T 470nF
3 _l+c3
ME 470uF DR4
S{ 1MEG
R5
1MEG
R8
1MEG
vDC
u
3K
VSS
Figure 11 Bus capacitor configuration and DC bus sensing
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3.1.2 ACinput rectifier and inverter section using FP25R12W1T7_B11

The AC input rectifier and inverter section is implemented using FP25R12W1T7_B11 as shown in Figure 12. Itis a
three-phase rectifier and three-phase inverter bridge section with Infineon’s TRENCHSTOP™ IGBT7. R15/R16/R17
(in parallel) are single shunt for current sensing.

o1
2 T1 P__POW_IN
1
Y xzx & 1
X R10 0 0 L1 L1 21 .
X1 E:f— T2 2 12 3 -
3 oM 3 13 .
2 VG UH ] VG UL X8
Y ] v N S
L:}_ 1 DC+ N
R9 0 2 R13 T P1
X2 3 T GB
3 7 oM R':]49 0k 1
2__VG VH _ ] 5 G VL NB ¥\ -
Y 6 ] B "
7
RI 0 B R4S 0 VG UHGL
X3 9 VG _ULG2
3 oM
2 __VGWH ] X5 VG WL EU |
1 W ]
i L
RI4—0
VG VHG3
VG VLG4 l
Connector to Motor EV |
112 \ v
211
VG_WHG5
+3V3 X9 VG_WLG6
L
20 W W
5k
SHUNT+ R19 FP25R1ZWLT7 BLL
ITRIP_R2L
1K
SHUNT-  R18
1K Lj
VSS
Figure 12 The diagram of the inverter section
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3.1.3 Drive circuit with 2ED1324S12P

A dedicated daughter board for the three half-bridge gate drivers 2ED1324S12P are mounted on top of the
mother board to drive the IGBT module. The configuration of 2ED1324S12P is shown in Figure 13.

The capacitor C3 (C9, C14) is used as bootstrap capacitor to provide the necessary floating supply voltage VBS.
Thanks to the bootstrap diode integration in 2ED1324S12P, an external bootstrap diode is not needed.

2ED1324S12P (high-voltage integrated circuit) HVIC is equipped with ITRIP input pin. This functionality can be
used to detect overcurrent events in the DC bus. When the HVIC detects an overcurrent event through the ITRIP
pin for one of the three phases, the output is shut down and the RFE is pulled to VSS to report the fault condition.
The outputs of the other two phases are also shut down because of the daisy chain connection with the RFE pins.
The RFE can also be used as the enable input pin and fault-clear time programmable pin.

The fault-clear time setup is based on the datasheet of 2ED1324S12P. The main feature of 2ED1324S12P designed
with Infineon’s C5SOI technology is its tolerance in terms of negative transient voltage in inductive load
applications. 2ED1324S12P can tolerate repetitive negative transient voltage of up to 100 V (pulse width up to
700 nanoseconds).
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Figure 13 Drive circuit design with 2ED1324S12P
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3.1.4 Overcurrent protection

The overcurrent circuit is shown in Figure 12. To save power loss of the shunt resistor, the Rewnt Value is set as 10
mQ by using three 30 mQ / 3 W surface-mounted devices (SMD) resistors (R15/R16/R17) and low equivalent series
inductance (ESL) in parallel. In the design, the target current for overcurrent protection (loce) is 25 A. The
overcurrent threshold of the ITRIP pin is 0.44 V. An additional 0.19 V DC-bias voltage is needed at the ITRIP pin to
meet the target current of 25 A. This is achieved by using resistor dividers R19 and R20 with 3.3V supply.

The locp is calculated using:

R19
(Virrip+ — RT9 3 170 * 3-3V) * (R19 + R20)

R20 * Rshunt
=2493 4

locp =

Here, Virrip+ is the positive-going threshold for ITRIP and its typical value is 0.44 V, R19 = 100 Q, and R20 =1 kQ.

Note: If EVAL-M1-101T is used as the controller board, the offset circuit needs to be removed from it, as this circuit is
already provided on the main board.

3.1.5 NTC thermistor configuration

FP25R12W1T7_B11includes a NTC thermistor. Its temperature curve is shown in Figure 14. The resistance of the
NTC thermistoris 5 kQ at 25°C and 493 Q at 100°C.

oo ———
3
J RIVD :
10000 \
‘\
~
é—' 1000
-4

1] 25 50 75 100 125 150 175
Tye ()

Figure14 Typical temperature characteristics of the NTC thermistor

A 1kQ pull-up resistor is provided on the daughter board. As shown in the NTC thermistor configuration in Figure
15, the sensing voltage VTH equals 2.75 V at 25°C and 1.09 V at 100°C. In the MCEWizard, the over-temperature
voltage threshold of the NTC thermistor is set to 1.09 V to protect the power module.

Note: If EVAL-M1-101T is used as the control board, the 4.87 kQ pull-up resistor for NTC needs to be removed to
avoid conflict with the pull-up resistor on the daughter board.
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Figure 15 NTC thermistor configuration

3.1.6 Auxiliary power supply

The auxiliary power supply circuit adopts the quasi-resonant, fly-back controller ICE5SQSAG and the CoolSiC™
1700 V SiC MOSFET IMBF170R1KOM1 in a TO-263-7 package. There are two secondary windings. One generates
15V DC and the other generates 7V DC. The 15V DC is connected to the gate drivers. 3.3V power supply is derived
from the 7V DC using the linear regulator IFX25001ME V33. This 3.3V power supply is used in the overcurrent bias
circuit. Both 15V and 3.3 V are also present at the 20-pin interface connector X22 on the daughter board. The
primary ground, and secondary +15 V and +3.3 V reference grounds are in a star ground connection on the main

board as shown in the schematic in Figure 18.

3.2 Schematics

The schematics of EVAL-2ED1324S12PM1 are shown in Figure 16, Figure 17, and Figure 18.
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Figure 18 Auxiliary power supply circuitry
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3.3 Layout

3.3.1 Layout details

Detailed layouts of the power inverter board and daughter board are shown in Figure 19 to Figure 22.

O

O

seem
g

Infirle

|
<

VAL-2ED1324512PM1

Figure 19 Power inverter board layout (top view)
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Figure 20 Power inverter board layout (bottom view)
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EVAL-2ED1324SC12PM1D

\ V1.0 )

Figure 21 Drive circuitry layout of the daughter board (top view)

Figure 22 Drive circuitry layout of the daughter board (bottom view)
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3.3.2 Layout guidelines
Some basic layout guidelines are as follows:
e TheVcc and Ves bypass capacitors should be close to the IC
o Thedrive loop should be as small as possible

o The loop of VSS and COM should be made as small as possible by connecting the VSS and COM directly
at the shunt-resistor terminals

e Thetwo current-sensing traces should be started from the shunt terminals and placed close to each other
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3.4 Bill of material

The complete bill of material (BOM) is available in the Downloads section of Infineon’s homepage. A login is
required to download this material.

Table 5 lists the important components used in EVAL-2ED1324S12PM1.

Table5 BOM of the most important/critical parts

No. Ref designator Description Manufacturer | Manufacturer P/N
U1/u2/u3 1200V half-bridge gate-driver with | Infineon
1 . . 2ED1324S12P
(daughter board) | overcurrent protection Technologies 3245
EasyPIM™ 1B power integrated Infineon
2 Q1 (mother board) | module with TRENCHSTOP™ . FP25R12W1T7_Bl11
Technologies
IGBT7
3 Ul (mother board) | Quasi-resonant controller Infineon . ICE5QSAG
Technologies
4 02 (mother board) 1700 V/1 Q SiC MOSFET in TO263-7 | Infineon ‘ IMBF170R1KOML
package Technologies
5 G1 (mother board) | > /400 mA linear voltage Infineon IFX25001TF V33
regulator Technologies
6 R1,R16, R17 30 mQ /3 W SMD shunt resistor Viking CS25FTG:RO30W
(mother board)
470 uF 450V alumi lectrolyti
7 C1, C3 (mother 1 . aluminum electrolytic Wiirth 861011486024
board) capacitor
0.47 uF film capacitor - 1000V (1 kV
8 C2 (mother board) HF film capacitor - 1000V (1 kV) | 890493427007CS
polyester, metallized radial
3.5 Connector details
Table6 Connectors
PIN Label Function
X1, X2, X3, X4, X5, X6 Daughter and mother board connections
DC+, DC- X7 (DC+/DC-, mother board) DC power supply input
L1, L2,L3 X8 (L1/L2/L3, mother board) Three-phase AC input
uv,w X9 (U/V/W, mother board) Three phase-outs (U/V/W) to the motor
X22 (daughter board) iMOTION™ MADK-M1 20-pin interface connector
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4 System performance

4.1 System setup for running a BLDC motor
EVAL-2ED1324S12PML1 is tested while running a BLDC motor in the setup shown in Figure 23.
Test conditions:
e Input: Viy=380VAC
e Phase-out current: lpuase =10.8 Arms
e Room temperature
e BLDC motor: GK6081-6AC31-FE, lpnase = 10.8 A, test at speed = 1500 r/minand 7.1 Nm

e Heat sink with natural ventilation for the six-pack module

To PC
Qﬁ'ﬁ SR =
1 I % “"ﬁa

u w n
< L mn mnen

9 B T r T T ]

«-2ED1324S12PM1

o7 g

=
202206, .

Figure 23 System setup for running a BLDC motor
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4,2 The output phase current

Figure 24 shows the waveform when running a BLDC motor.

Tek Stop

CH1 - Vgs.
CH2 - Vash
CH4 - lpnanse-u

(@ 100v & @ @ 1004A &) [S.OOms Mzsorvlsx_s ] @ - 1.00 AJ
@ Max 16.2V } 20M points
2
@ RS 10.8 A 23 Apr 2022
18:04:55

Figure 24 Phase U output current 10.8 A waveform at V,y=380 VAC, P,y =2 kW, Fsyw = 8 kHz

4.3 Test result for overcurrent protection

Figure 25 shows the overcurrent detection function of EVAL-2ED1324S12PM1 by ITRIP input of 2ED1324S12P.
Overcurrent detection shuts down the outputs of the gate driver if the ITRIP pin input is over 440 mV and lasts
longer than 500 nanoseconds. In that case, the overcurrent protection starts when the peak current is around

2493 A.

5 5 : CH1_ REF

] ® -3.925us 3.000 V
) . 4 . O 282.8us 1.720 v
...... A A S azsoms  aiasov | (Faultreport)

CH4 - |PHANSE— u

[ ] 2.00\.f= 2 @ 2004 ]2uu; 500MS/ .1 1.80V
gmls 8.29 A j[ 3 ][anoinstS] }
23:10:02
Figure 25 Overcurrent protection
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4.4 Test result for short-circuit protection

Figure 26 shows the short-circuit protection of EVAL-2ED1324S12PM1. The total short-circuit protection delay
time (including external RC filter, 1 k2 / 150 pF) is about 650 nanoseconds when the input voltage Viyis 600 V and

the maximum current is about 87 A.

Tek Prevu M 400pus Trig?
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Edylu ;
ek CH2 - Vgs,
[vaet CH3-GK
[13Lin
Zoom Factor: 400 X Zoom Position: 2.03.15 o ] ] (Fault repor‘t)
: : : @ 550.000ns 23.00a | CH4 - lppanse-u
o . . : . R : . © 1.20000ps 91.00 A
: : ,0‘ M A650.000ns AB8.00 A
PN :
3, ey e : : i WM" i
[Z4Vge | gtz |- L:%* e e oty e T e T o
n linw' : [ R, bt
: . . . | . j
(@ So0v @ ' [ ) 2.00V a4 5004 'j[z 1.00us ' Ms.oncs}s ] ' o 5 .10 VJ
tr\nax 810V } 20M points
2
16:57:41

Figure 26 Short-circuit protection at V,y=600 V

4.5 Inverter’s efficiency vs input power

Figure 27 shows the inverter’s efficiency vs different input powers at Viy=380 VAC, lpuase = 6.7 A, Fsw = 8 kHz, and
T,=25°C.

Efficiency (%)
00 (o] (o] [0 0] (o) (o) [(o] (o]
N S [e)] (o] o N H [e)]

[e]
o

545 948 1382 1824
Pin (W)

Figure 27 Inverter’s efficiency vs input power at Viy= 380 VAC, lpuase = 6.7 A, Fsw =8 kHz, T.=25 °C
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4.6 Inverter’s efficiency vs carrier frequency

Figure 28 shows the inverter efficiency vs different carrier frequencies at Vin=380 VAC, lpuase = 6.7 A, Py = 2 kW,
and T,=25°C.

Efficiency vs carrier frequency
100
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T 97
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Figure 28 Inverter efficiency vs carrier frequency at Viy=380 VAC, lpuase = 6.7 A, Pin =2 kW, T.=25°C
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5 References and appendices

5.1 Abbreviations and definitions

Table 7 Abbreviations

Abbreviation Meaning

IC Integrated circuit

IGBT Insulated gate bipolar transistor
DC Direct current

AC Alternating current

BLDC Brushless direct current

PIM Power integrated module

PWM Pulse width modulation

NTC Negative temperature coefficient
EVAL Evaluation board

PCB Printed circuit board

SOl Silicon on insulator

5.2 References

[1]  Infineon Technologies AG. Datasheet of 2ED1324S12P (2020) V1.3 2ED1324S12P - Infineon Technologies

[2] Infineon Technologies AG. Datasheet of FP25R12W1T7_B11 (2020) V0.10 FP25R12W1T7 B11 - Infineon
Technologies

[3] Infineon Technologies AG. Datasheet of ICE5QSAG (2020) V2.1 ICE5QSAG Infineon Technologies

[4] Infineon Technologies AG. Datasheet of IMBF170R1KOM1 (2021) V2.3 IMBF170R1KOM1 Infineon
Technologies

[5] Infineon Technologies AG. Datasheet of IFX25001TF V33 (2019) V1.10 |IFX25001TF V33 Infineon
Technologies

[6] Infineon Technologies AG. User manual of EVAL-M1-101T (2018) V1.6 EVAL-M1-101T - Infineon
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[71  Infineon Technologies AG. Application note: Managing transients in control IC driven power stages (2017)
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